PE CUONG ON TAP HOC KY 2 - 2020

A.LY T‘HUYET
I. Yél} cau
a. Kién thirc

* Biét droc:
Chuong 3

e  Biét cac chirc nidng chung ctia hé soan thao vin ban.

e  Biét cac don vi xtr Iy trong van ban (ky tu, tir, ciu, dong, doan, trang).
Biét cac van dé lién quan dén soan thao van ban tiéng Viét
Biét man hinh 1am viéc cia Word
Biét khai niém va céc thao tac tim kiém, thay thé, copy, dan
Biét dung cac cong cu dé v& hinh, chén anh
Biét cac thao tac: tao bang; chén, xo4, tach, gdp cac 0, hang va cot.
Biét soan thao va dinh dang bang.

Chuong 4
e  Biét duoc cac khai niém chinh : mang, internet, LAN, WAN,
e  Phan biét dugc cac thiét bi mang c6 day, khong day.
e Biét dugc cach giao tiép giita cac may tinh v6i nhau,

* Hiéu dwoe:

Chuong 3
e Hiéu cic thao tac soan thao vin ban don gian: mé tép vin ban, gb van ban, ghi tép.
e Hiéu khai niém va cac thao tac dinh dang ky tu, dinh’ dang doan van ban, dinh dang
trang van ban, danh sach 1iét ké, chén so thur ty trang. Biét cach in van ban.

Chuong 4
e Hiéu khai niém cac khai niém : mang, mang Internet,
e  Phan bi¢t dugc cac mo hinh mang,

* Vin dung:
e V& duoc cac so do mang, phan loai dugc mo hinh mang theo phan loai dia ly
e  Thuyc hién viéc soan thao, trinh bay ndi dung bai kiém tra, ndp bai kiém tra qua E-
mail
e Trinh bay dé c6 thé in vin ban ra gidy

b. Ky nang:
e  Thuyc hién dugc viéc soan thao van ban don gian.
Thuc hién dugc cac thao tac md t€p, dong t&p, tao t€p mdi, ghi tép van ban.
Dinh dang dugc vin ban theo mau doan vin
Thuec hién duoc tim kiém va thay thé mot tur hay mdt cau,
Thuc hién dugc tao bang, cac thao tac trén bang va soan thao van ban trong bang.
Thuc hién dugc cac chirc nang v€, nhom, b tri hai hoa



B. BAI TAP
CHUONG III

BAI 14: KHAI NIEM VE SOAN THAO VAN BAN (11 ciu)

14.1. Chtrc nang chinh cua Microsoft Word 1a gi?
A. Tinh toan va lap bang biéu

B. Tao cac tép dd hoa

C. Soan thao van ban

D. Chay céac chuong trinh ing dung khac

14.2. Hay chon phuong an tra 10i ding nhét.

Sap xép cac viée sao cho ding trinh ty thudng duge thuc hién khi soan thao van ban
trén may tinh.

(1) chinh stra (2)in4dn  (3) gb van ban (4) trinh bay

A3-1-4-2
B.1-2-3-4
C.3-4-1-2
D.4-3-2-1

14. 3. Khi trinh bay van ban, khong thuc hién viéc nao dudi day?
A. Thay d6i khoang cach giita cac doan

B. Stra chinh ta

C. Chon c0 chir

D. Thay d6i hudng gidy

14.4. Chon cau dung trong cac cau sau

A. H¢ soan thao van ban tu dong phan cach céc tur trong mot cau.

B. Hé soan thao van ban quan Iy tu dong viéc xudng dong trong khi ta gd vin ban.

C. Céac hé soan thao vin ban déu co phﬁn mém X 1y chir Viét nén ta co thé soan thao
van ban chir Viét.

D. Trang man hinh va trang in ra gidy ludn cé cung kich thudc.

14.5. Bé nhap cau “Hoc dé ngay mai lap nghiép”, diy ki tu can gd theo kiéu Telex 1a
A. Hocj ddeer ngayf mai laapj nghieepj

B. Hoc de ngay mai lap nghiep

C. HOCJ DEER NGAYF MAI LAAPJ NGHIEEPJ

D. HOC DE NGAY MAI LAP NGHIEP

14.6. Trong cac ménh dé sau noi vé quan hé giira bang ma va phong chit, ménh dé nao
dung

A. Mot bang ma ap dung cho tit ca cac phong chir

B. Mdi bo phong chir xay dung dwa trén mot bang ma nhat dinh

C. M6t bo phong chir ¢ thé ap dung cho nhiéu bang ma



14.7. Bé soan thao duoc tiéng Viét trén may tinh, diéu kién nao duéi day la gu?
A. Phian mém soan thao, bd gd tiéng Viét, phdn mém gd ban phim tiéng Viét

B. Phan mém soan théo, phan mém g0 ban phim tiéng Viét

C. Phan mem soan thao, phong tleng Viét, man hinh t6i thiéu 256 mau

D. Phian mém soan thao, phong tiéng Viét, phan mém gd ban phim tiéng Viét

14.8. Bang ma Unicode phu hop véi phong chir:
A. Times New Roman

B. .VnTimes

C. VNI-Times

D. VNTimes New Roman

14.9. Hay chon cdc phuong an diing
Bang mé nao sau day hd tro tiéng Viét:
A. TCVN3 - ABC

B. VNI

C. ASCII

D. Unicode

14.10. Hay chon t6 hop cac phwong an tra 10i thich hop nhit dé dién vao cac 6 trong
trong phat biéu dudi day:

Hé soan thao vin ban 1a mét phan mém ...... cho phép thuc hién céc ...... lién quan
dén viéc tao van ban nhu g0 van ban, sua doi, ...... , luu trir va in van ban.

A. dich vu — cong viéc — sao chép

B. tng dung — dich vu - trinh bay

C. ung dung — thao tac — trinh bay

D. hé thong — thao tac — sao chép

14.11.Muc nao dudi day sip xép theo tht ty don vi xir Iy van ban tir nho dén 16n?
A. ki tu - cau — tir - doan van ban
B. ki tu - tir - cau — doan van ban
C. tur - ki tu - cau — doan van ban
D. tir - cau — doan van ban — ki tu

BAI 15: LAM QUEN VOI MICROSOFT WORD (16 ciu)
15.1. Cau nao dang trong cac cau sau?
A. Word 13 phan mém tmg dung
B. Word 1a phan mém hé théng
C. Word 14 phan mém tién ich
D. Céc cau trén déu sai

15.2. Cach nao trong cac cach sau cho phép sir dung ban phim dé mé bang chon?
A. Nhén giit Ctrl r0i g6 ki tu gach chan trén bang chon

B. Nhén gitt phim Shift roi g5 ki tu gach chan trén bang chon

C. Nhan giit phim Alt roi gé ki tu gach chéan trén ban phim



D. Khong c¢o6 cach nao

15.3. T6 hop phim ghi & bén phai mot sé muc trén bang chon 1a
A. chi dan cach dung bang chon

B. chi ra bang chon con

C. phim tét dé thyuc hién 1énh twong Gmg

15.4. Nhitng phat biéu nao sau day 1a dung ddi v6i viée st dung phim tit?
A. Mét nhiéu thoi gian hon

B. Phai nh¢ t6 hop phim

C. Can phai nh¢ t6 hop phim twong tng

D. Nhanh hon

15.5. Hay chon phuong an khong chinh xac trong cac phuong an sau
Mudn hity bé mét thao tac vira thue hién, chiang han x6a nham mot ki tu, ta
A. Chon Iénh Edit --> Undo

B. nhén t6 hop phim Ctrl + Z

C. chon 1én Edit --> Redo

15.6. Hay chon phuong 4n khong chinh xac trong cac phuong an sau
Mudn lwu van ban vao dia, ta

A. Chon biéu tuong chiéc dia trén thanh cong cu

B. nhén t6 hop phim Ctrl + S

C. Nhan t6 hop phim Alt + S

D. Vao File --> chon Save

15.7. Nhén cac phim Ctrl + End déng thot s€ thuc hién viéc nao trong cac vi¢c sau
A. Pua con tro vian ban dén cudi tir hién tai

B. Pua con tro van ban dén cudi doan van ban hién tai

C. Pua con trd vian ban dén cudi dong hién tai

D. Pua con tré vin ban dén cubi vin ban

15.8. Pé sao chép doan vin ban tir vi tri nay dén vi tri khac trong mot van ban bang
cach kéo tha chudt, can phai nhan va giit phim nao trong khi kéo tha?

A. Nhén giir phim Shift

B. Nhén gitt phim Ctrl

C. Nhan gitr phim Alt

D. Nhén giit ca Alt va Ctrl

15.9. Hay chon nhitrng cdu sai trong cac cau sau

A. Céc tép soan thao trong Word 2003 ¢6 dudi ngam dinh 1a DOC.

B. Dé két thiic phién lam viéc voi Word , cach duy nhat 1a vao File --> Exit.
C. Mbi lan luu van ban, ngudi dung déu phai cung cép tén tép van ban.

D. C6 nhiéu cach dé mé tép vin ban trong Word.



15.10. Hay chon cau sai trong cac cau sau

A. Trong mét doan van ban, phai nhan phim Enter dé chuyén con tré vin ban xubng
dong

B. Trong mot doan van ban, khong dung phim Enter dé chuyén con tré vin ban xubng
dong

C. Khéng sir dung dong tréng dé phan cach cac doan vin ban

15.11. Thoat khoi chuong trinh Microsoft Word, ta st dung menu 1énh
A. File --> Close

B. File --> Exit

C. File --> Print

D. File --> Print Preview

15.12. Mubn x6a ki ty dimg trude con trd soan théo, ta dung phim:
A. End

B. Backspace

C. Insert

D. Delete

15.13. Bé mé méi mot van ban, tir bang chon File, ta str dung 1énh
A. New
B. Open
C. Save
D. View

15.14. Phim Space c6 churc nang:
A. Tao mot ki tu tréng

B. X6a mot ki tu

C. Xubng dong

15.15. Trong khi 1am viéc v6i Word, t6 hop phim tit ndo cho phép chon toan bo (tat
cd) van ban dang soan thao.

A.Alt+F

B. Ctrl + A

C.Cltr+F

D. Alt+ A

15.16. Trong soan thao vin ban Word, mudn chuyén ddi gitta hai ché do gb: ché do
chén va ché d6 d¢, ta badm phim:

A. Insert

B. Caps Lock

C. Delete

D. Tab

BAI 16: PINH DANG VAN BAN (12 ciu)



16.1. Gia sir d3 ¢6 cum tr “Tin hoc Phé thong”, dé thay ddi dinh dang ki tu cho cum
tir nay, trudc tién ta phai thuc hién thao tac nao dudi day?

A. Dung phim tit Ctrl + I

B. Chon toan by cum tir do

C. Chon ttr cudi ciing

D. Pua con tré van ban dén cum tir d6

16.2. Bé thay ddi ¢& chit cia mot nhom ki tu dd chon, ta thyc hién 1énh Format -->
Font... va chon c& chir trong 6:

A. Font Style

B. Font

C. Small caps

D. Size

16.3. Bé dinh dang cum tir “Viét Nam” thanh “Viét Nam”, sau khi chon cum tur do, ta
can sir dung t6 hop phim nao dudi day?

A. Ctrl +1

B.Ctrl + U

C.Ctrl + B

D.Ctl+E

16.4. Bé gach dudi mot tir hay cum tur, sau khi chon cum tir do, ta can sir dung to hop
phim nao dudi day?

A. Ctrl +1

B.Ctrl + U

C.Ctrl +D

D.Ctrl + E

16.5. Hay chon phuong an ghép t6t nhat cho cau sau:

Khi mudn thay d6i dinh dang mot doan van ban, trude tién ta phai:
A. chon toan by doan van ban do

B. chon mot dong thudc doan van ban dé

C. dua con trd vin ban dén doan van ban do

D. a, b, ¢ déu duoc

16.6. Dé can 1& déu hai bén cho doan van ban, sau khi dua con tré dén doan van can
dinh dang, ta thuc hién:

A. File --> Page Setup...

B. Nhan t6 hop phim Ctrl + J

C. Format --> Justify

D. Nhén t6 hop phim Ctrl + E

16.7. Bé dinh dang trang, ta can thuc hién 1énh:
A. File --> Page Setup...
B. File --> Printer Setup...



C. Edit --> Page Setup...
D. Format --> Page Setup...

16.8. Trong Microsoft Word, ta muén dit 18, chon c& gidy, hudng gidy ta sir dung 1énh
nao?

A. File --> Print

B. File --> Print Preview

C. File --> Page Setup

16.9. Bé canh gitra cho mot doan van ban, ta nhén:
A.Ctrl + L
B. Ctrl + R
C.Cul+E
D. Ctrl +1]

16.10. Cong viéc nao sau day khong lién quan dén dinh dang vin ban?
A. Thay d6i phong chix

B. Déi kich thudc trang gidy

C. Thay ddi khoang cach giira cac dong

D. Stra 16i chinh ta

16.11. Cong viéc nao dudi day khong lién quan dén viéc dinh dang trang ctia mot van
ban?

A. Dit kich thudc 18

B. Déi kich thudc trang gidy

C. Pit khoang cach thut dau dong

D. Pit huéng cta gidy

16.12. Chon nhitng cau ding trong c4c cau sau:

A. Khi soan thao c6 thé thiét dat ché do dé Word tu dong danh ) trang

B. C6 thé thiét dat dé in sd trang & dau trang hodc cubi trang

C. Dé in ngay toan bo vin ban thanh nhiéu ban chi can nhan nit Print trén thanh cong
cu

D. Pé c6 thé in mot van ban thanh nhiéu ban in chon 1énh File --> Print hodc nhén t6
hop phim Ctrl + P

BAI 17: MOT SO CHU'C NANG KHAC (10 ciu)
17.1. Hay chon cdc phwong an dung
Pé danh sb thir ty cac doan vin ban, ta chon cac doan van ban dé rdi thuc hién:
A. Nhay chuét vao nat Iénh Numbering trén thanh cong cu
B. Lénh Edit --> Bullets and Numbering...
C. Lénh Format --> Bullets and Numbering...
D. Lénh Insert --> Bullets and Numbering...



17.2. Viéc nao trong nhiing viéc dudi day s& khong thuc hién duoc khi ta danh sd trang
trong Word bang 1énh Insert --> Page Numbers...?

A. bat sé thir tu trang & dau trang hay phia duéi cia trang

B. bat so thir tur & gilra hodc bén mép trai hay mép phai cua trang

C. Dit sb thur ty trang ¢ cac vi tri khac nhau dbi v6i trang chin va trang 1é

D. Panh s6 trang bang chir (mét, hai, ba,...)

17.3. Khi nhay nut Print trén thanh cong cu, diéu gi s& xay ra?
A. Trang hién thoi s€ duoc in ra

B. Trang dang chira con tré van ban s€ duoc in ra

C. Toan bo van ban sé duoc in ra

D. Phan dang chon s€ dugc in ra

17.4.Hay chon cdc phwong dan ghép dung.

Pé xem vin béan trude khi in, ta

A. chon File --> Print Preview

B. chon View --> Print Preview

C. chon File --> Page Setup

D. Nhay nut 1énh Print Preview trén thanh cong cu

17.5. D¢ thyc hién in vén ban, ta thuc hién
A. 1énh File --> Print...

B. 1énh File --> Page Setup...

C. nhay nut Print trén thanh cong cu

D. nhén t6 hop phim Ctrl + P

17.6. Hay chon cdc phuong an dung

Dung Iénh File --> Print... ta c6 thé in véi cac lua chon sau:
A. Toan bd van ban

B. Nhiéu hon mét vin ban

C. Céc trang khong lién tiép nhau

D. Tir ddu van ban dén mot trang nao d6

17.7. Nhitng phat biéu nao 1a sai trong cac phat biéu sau:

A. Lénh File --> Print... cho phép in ngay toan bo van ban

B. Nt 1énh Print trén thanh cong cu cho phép in ngay toan bd van ban

C. Nut I¢én Print trén thanh cong cu cho phép in van ban voi nhiéu lya chon
D. Dung t6 hop phim Ctrl + P ta c6 nhiéu lya chon dé in vin ban

17.8. Pé trinh bay van ban theo kiéu liét ké, ta dung 1énh nao sau day?
A. Format --> Tab

B. Format --> Bullets and Numbering

C. Format --> Paragraph

D. Format --> Direction



17.9. Bé danh sb trang cho mét file van ban, ta dung 1énh:
A. Insert --> Page Numbers

B. Insert --> Date and Time

C. Insert --> Break

17.10. Bé chén dau ngit trang, ta dung 1énh:
A. Insert --> Picture

B. Insert --> Break

C. Insert --> Page Number

D. Insert --> Date and Time

BAI 18: CAC CONG CU TRQ GIUP SOAN THAO (2 ciu)
18.1. Hay chon cdc phuong an ghép dung
Dé tim cum tir “Thing Long” trong doan vin ban va thay thé thanh “Péng D6”, ta thuc
hién
A. 1énh Edit --> Go to...
B. Edit --> Search
C. Iénh Edit --> Replace...
D. nhéan t6 hop Ctrl + H

18.2. Tim cau sai trong cac cau sau

A. Ngém dinh, tir dugc go vao 6 Find what 1a “Viet Nam” thi tat ca cac tir sau déu duoc
tim thay “Viet Nam”, “VIET NAM”, “viet Nam”, “Viet nam”

B. Chirc ning thay thé cho phép thay mot tir bang mot tir hodc cum tir voi diéu kién sb
luong ki tu tim va thay thé phai bang nhau.

C. Chirc ning thay thé cho phép x6a mot tir hay mot cum tir trong van ban.

Bai 19: TAO VA LAM VIEC VOI BANG (4 céu)

19.1. bBé tao bang ta thuc hién

A. 1énh Table = Insert > Table...
B. Lénh Insert > Table

C. Nhan t6 hop phim Ctrl + T

D. Nhén t6 hop phim Alt + T

19.2. Trong cac cach dudi ddy, cach nao nén dung dé can chinh ndi dung trong mot
xubng sat day?

A. Dung céc khoang trong trude ndi dung

B. Nhan nhiéu lan phim Enter

C. Chon nut Iénh Cell Alignment

D. Nhan Ctrl +]J

19.3. Lénh Format = Borders and Shading... dung dé
A. tao duong vién va to6 mau nén cho doan van ban
B. dinh dang van ban



C. tao duong vién va td6 mau nén cho bang
D. tao duong vién va t6 mau nén cho ki tu

19.4. Chon cau sai trong nhitng cau sau:

A. C6 thé tao bang bang cach: chon 1énh Table > Insert > Table...

B. C6 thé tao bang nhanh béng cach chon nut 1€nh Insert Table trén thanh cong cu
C. Khéng thé gdp nhiéu 6 trong mot bang thanh mot 6

D. Vian ban trong moét 6 cua bang dugc dinh dang nhu van ban thong thuong.

CHUONG IV

BAI 20. MANG MAY TiNH
20.1. Phat biéu nao 1a sai trong cac phat biéu sau:
A. Mang c6 day két ndi cac may tinh bang cap
B. Mang khong day két ndi cac may tinh bang song radio, birc xa hong ngoai, song
truyén qua vé tinh
C. Mang khong day khong chi két ndi cac mdy tinh ma con cho phép két ndi cac dién
thoai di dong
D. Mang c6 day c6 thé lap dat cap dén bat ctr dia diém nao va khong gian nao

20.2. Hay xac dinh nhitng cau nao dudi day mo ta mang cuc bo (LAN)

A. Ba may tinh va mot may in két ndi v6i nhau, c6 thé dung chung may in

B. Mot may tinh & Ha Noi va mot mdy tinh & Quang Tri c6 thé trao d6i va sir dung
chung céc tai liéu

C. 150 may tinh hoat dong doc lap trén tang 4 cla Trung tam day nghé Hai Ba Trung
D. 200 may tinh & cac ting 2, 3, 4 cua tda nha cao tang duoc ndi cap v6i nhau dé ding
chung dir li€u, may in va cdac tai nguyén khac.

20.3. Tim phat biéu sai vé cac dich vu duoc hd trg béi mang LAN trong cac phat biéu
néu dudi day

A. Dung chung dif liéu va truyén tép

B. Dung chung cac tng dung va cac thiét bi ngoai vi (mdy in, may quét, may fax,
moderm,...)

C. Cho phép giri va nhan thu dién tir (email) trén toan cau

20.4. Mang may tinh la

A. tap hop cac may tinh

B. mang Internet

C. mang LAN

D. tap hop cac may tinh duoc ndi voi nhau bang cac thiét bi mang va tuan theo mot
quy uéc truyén thong

20.5. Bé két ndi cac may tinh, nguoi ta
A. st dung cép quang



B. sir dung cap chuyén dung va duong dién thoai
C. str dung duong truyén vo tuyén
D. tat ca cac cau trén

20.6. Trong cac thiét bi ndo dudi day, thiét bi ndo khdng phai 1a thiét bi mang
A. Vi mang

B. Hub

C. Moderm

D. Webcam

20.7. Phat biéu ndo sau day vé mang khong day 1a sai? ’

A. Trong cung mot van phong, mang khong day duoc lap dat thuan tién hon mang cé
day

B. B6 dinh tuyén khong day thuong keém ca chirc nang diém truy cap khong day

C. Mang khong déy thong thuong cé tbe do truyén dit liéu cao hon hin mang c6 day
D. May tinh tham gia vao mang khong day phai dugc trang bi vi mang khong day

20.8. Hay chon t6 hop cac phuong an thich hop nhit dé dién vao cac 6 tréng trong phat
biéu dudi day

Giao thirc truyén thong 14 bd cic ...... cu thé phai tuan thu trong viéc trao doi ......
gilita cac thiétbi ...... C6 cac giao thire do1 véi toc do truyén, khudn dang dit 1i€u, kiém
soat 101,..

A. quy tac — thong tin — truyen dir liéu
B. thong sO - thong tin — truyén dir liéu
C. quy tic — dit liéu — thong tin

D. quy tic — thong tin — mang

20.9. Mang cuc bg 1a mang

A. c¢6 10 may tré xudng

B. két ndi cac may tinh trong mot pham vi dia 1y rong 16n

C. cua mot gia dinh hay ciia mot phong ban trong mot co quan
D. két nbi mot s6 luong nhé may tinh & gan nhau

20.10. Mang di¢n rong 1a

A. mang c6 100 may tré lén

B. mang lién két cac mang cuc bd béng céc thiét bi két ndi
C. mang internet

D. mang cua mot quic gia

BAI 21. MANG THONG TIN TOAN CAU INTERNET
21.1. Chon phat biéu néu ding nhit ban chét cua Internet trong cac phat biéu sau
A. La mang 16n nhét trén thé gioi
B. La mang c6 hang triéu may chu
C. La mang cung cap khéi luong théng tin 16n nhat
D. La mang toan cdu va sir dung bo giao thirc truyén thong TCP/IP



21.2. Cau nao trong cac cau sau 13 phat biéu chinh x4ac nhat vé mang internet
A. 12 mang ctia cac mang, c6 quy md toan cau

B. la mang str dung chung cho moi nguoi, c6 rat nhiéu dit liéu phong phu

C. la mang c6 quy m6 toan cau hoat dong dya trén giao thirc TCP/IP

D. 12 m6i trudng truyén thong toan cau dua trén k¥ thudt may tinh

21.3. Phan mém nao dudi ddy khéng phai 1a trinh duyét web?
A. Netscape Navigator

B. Microsoft FrontPage

C. Google Chrome

D. Firefox

21.4. www 1a viét tit cia cum tir ndo sau day?
A. World Wide Wed

B. World Win Web

C. World Wired Web

D. World Windows Web

21.5. Phat biéu nao vé website dudi day 1a phu hop nhat?

A. 12 mot may chi cung cap dich vu web

B. 1a mdt trang chu

C. 1a mot hodc mot sb trang web duoc t6 chirc dudi mot dia chi truy cap
D. 1a mot hodc mot sd trang web cua cung mot t chire

21.6. Phat biéu nao dudi day vé trang web tinh 13 chinh xac nhat?
A. la trang web chi chira n¢1 dung van ban

B. la trang web khong chira cac hinh anh dong nhu doan phim video
C. la trang web khong c6 kha nang tuong tac véi nguoi dung

D. 1a trang web khong cung cép chirc ning tim kiém thong tin

21.7. Trang chu la

A. trang web dau tién dugc mo ra khi truy cap mot website
B. trang web huéng dan sir dung website

C. dia chi chinh thirc cia mot website

D. trang web cua ca nhan

21.8. Nhiing phat biéu nao duéi ddy 1a khéng chinh xac?

A. Mang LAN la mft mang may tinh khong day

B. Mang may tinh 16n nhat 1a mang internet

C. Trong mang LAN vira c6 két ndi c6 day vira co két ndi khong day

D. Khong c6 mang may tinh hdn hop vira két ndi co day vira két ndi khong day

21.9.Chon cau dang trong cac cau sau:
A. Khong c6 cach nao dé dam bdo an toan thong tin mot cac tuyét doi ca



B. M6i phan mém chong virus chi c6 thé tim va diét dang mot loai virus
C. Chi c6 nguodi nao phat tan virus méi viét dugc phan mém diét virus do

21.10. Cach truy cap nao dudi day duoc coi 1a bat hop phap?

A. Truy cdp vao may cua nguodi khac

B. Truy cp vao may bang tén va mat khau cia ngudi khac ma ngudi d6 khong biét
C. Truy cap vao may chu

BAI 22. MOT SO DICH VU CO BAN CUA INTERNET
22.1. Chon cau dung trong cac cau sau
A. Hop thu dién tir dugc dat @ mot may chu. Vi may chu do6 co6 dia chi duy nhét nén
dia chi hop thu dién tir cling duy nhét
B. Hai nguoi khac nhau c6 thé sir dung chung mét hop thu dién ti néu ho cung c6 mat
khau truy cap
C. M3a hoa dir li€u 1a cac bao mat an toan tuyét ddi
D. Truy cép dir li¢u theo mat khau 1a cich bao mat an toan

22.2. Hay chon nhirng cau ding trong cac cau sau:

A. Trong thu dién tir c6 dinh kém tép, ngudi giri c6 thé néu giai thich ngan gon mot sb
diém vé tép gui kém

B. Khi chua c6 thu phan hdi, nguoi giri khiang dinh duoc ring ngudi nhan chua nhin
duoc thu

C. Chi nguoi nhan thu méi c6 thé truy cép tép dinh kém

D. Trong hdp nhén (inbox) khong thé cé thu cua ngudi khong quen biét

22.3. Béi twong nao dudi ddy s& gitip ta tim thong tin trén internet?
A. May tim kiém

B. B¢ giao thtrc TCP/IP

C. May chu DNS

D. Méy chu server

22.4. Phat biéu nao dudi day 1a sai?

A. M&i may chu chi can cai dit mot phan mém chéng virus 13 c6 thé tim va diét tat ca
cac loai virus

B. Mdi phan mém chdng virus chi c6 thé tim va diét dung mot loai virus

C. Khéng c6 phan mém chdng virus nao c6 thé tim va diét tit ca cac loai virus

D. Nhing ngudi dua virus 1én mang nham muc dich phé hoai 14 vi pham phap luat

22.5. Nhitng ndi dung nao dudi day 13 quan trong ma em can phai biét khi sir dung
internet?

A. Nguyén tic bao mat khi trao d6i thong tin trén internet

B. Cac luét ban quyén lién quan dén st dung internet

C. Nguy co lay nhiém virus

D. Kiéu b tri cac may trong mang



